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C H A P T E R 1
Introduction
This document provides the following information for Oracle WebLogic Integration (WLI) 10g 
Release 3 (10.3):

Overview of Oracle WebLogic Integration

Supported Configurations

Supported Configurations

Installation and Required Patches

Upgrading Applications

Tutorials to Help you Get Started

Known Limitations

Overview of Oracle WebLogic Integration
WebLogic Integration (WLI) is a comprehensive Java-based solution that provides a consistent 
and scalable approach to integration of systems, data, and people. It combines the divergent 
pieces of application and enterprise integration, including Enterprise Resource Planning (ERP), 
Customer Relationship Management (CRM), legacy applications, business users, supply chains, 
and trading partners. 

Oracle WebLogic Integration 10g Release 3 (10.3) is the latest version of WLI. It extends the 
features and benefits of WLI 10.2 to enterprise customers who are looking for new and efficient 
ways to meet their integration requirements in a constantly changing business environment.
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Oracle WebLogic Integration 10g Release 3 (10.3): 

Is built on Oracle WebLogic Server 10.3, which is the latest version of WebLogic Server. 

Uses Oracle Workshop for WebLogic 10.3, which is the latest version of Workshop for 
WebLogic. 

Interoperates with Oracle Service Bus 10.3, Oracle Enterprise Repository 10.3, and Oracle 
SOA Suite components. 

Supports security and accessibility rules of Oracle. 

Provides greater security by ensuring that sensitive information like user credentials is now 
encrypted and stored in the configuration files. 

For more information, see Overview of Oracle WebLogic Integration.

Supported Configurations
Supported operating systems: See List of Supported Operating System Configurations.

Supported databases and database drivers: See Supported Database Configurations.

For more information, see the WLI Upgrade Guide.

Installation and Required Patches
You can install the software by using either graphical mode, console mode, or silent mode. The 
installation program prompts you to enter specific information about your system and 
configuration. For more information, see the Products Installation Guide.

When you install Oracle WebLogic Integration 10g Release 3 (10.3), the required patches in 
Table 1-1 are installed automatically. If you uninstall any of these required patches and need to 
reinstall them, use the information in Table 1-1 in conjunction with the Smart Update utility to 
reinstall and apply the patches. For detailed information on using Smart Update, see Installing 
Patches and Maintenance Packs Using Smart Update.

Table 1-1  List of Required Patches for 10g Release 3 (10.3)

Patch Passcode

2GLK IILM29PJ

2LR5 JS484GZV
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http://download.oracle.com/docs/cd/E13196_01/platform/suppconfigs/configs103/103_over/overview.html
http://download.oracle.com/docs/cd/E13196_01/platform/suppconfigs/configs103/103_over/supported_db.html
http://download.oracle.com/docs/cd/E13160-01/wli/docs10gr3/upgrade/index.html
http://download.oracle.com/docs/cd/E13160-01/wli/docs10gr3/overview/index.html
http://download.oracle.com/docs/cd/E12840_01/common/docs103/install/index.html
http://download.oracle.com/docs/cd/E12840_01/common/smartupdate/guide/index.html
http://download.oracle.com/docs/cd/E12840_01/common/smartupdate/guide/index.html


I ns ta l la t i on  and  Requi red  Patches
3L6X UTWGCRT3

6V9X LMX2IKAH

8PPJ 3VETHS8L

CRB1 KCEMHQND

D3YH LSYU6SCD

D4TQ X1YAPFFB

DU61 8FN3RHEP

ET7A HEZ9M4L9

F1HX J2K6ELDA

FCMI TJBDD6RG

HW67 3ISW9IXH

LFMA M4SKBRZV

LULD 86DUK61T

QJIZ JU5N7P7U

R6VX NTAYD7MD

R8FE L1MRQ649

SWX2 DFK2LYU6

WB4R BXWBVYN8

XT7H MLI1PFWV

Table 1-1  List of Required Patches for 10g Release 3 (10.3)

Patch Passcode
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Upgrading Applications
You can upgrade WLI 8.1 (SP4, SP5 and SP6), WLI 8.5 (SP5 and SP6), WLI 9.2, and WLI 10.2 
applications to Oracle WebLogic Integration 10g Release 3 (10.3) by using the upgrade tools. For 
more information, see WLI Upgrade Guide.

Note: The upgrade process might involve a large number of files, and therefore might require 
more memory. So before starting the upgrade process, temporarily increase the 
maximum amount of memory that the JVM allows for Oracle Workshop for WebLogic. 
The recommended maximum memory is 1 GB.

You can change the maximum memory by setting the -Xmx value in the workshop.ini 
file, which, by default, is in the BEA_HOME\workshop_10.3\ folder. For example, you 
can change the maximum memory from -Xmx768m (default) to -Xmx1G (1 GB).

After upgrading your applications, revert the maximum memory to a level that is 
appropriate for development.

Tutorials to Help you Get Started
To get hands-on experience with Oracle WebLogic Integration, we recommend that you try out 
the following tutorials:

Upgrading WLI 8.1 or Higher, WLI 9.2 and WLI 10.2 Application Source to Oracle 
WebLogic Integration 10g Release 3 (10.3)

Designing Your First Business Process

Building Your First Data Transformation

Building a Worklist Application

Tutorials for Trading Partner Integration

In addition, you can try out the Oracle Workshop for WebLogic tutorials.
1-4 Oracle WebLogic Integration Release Notes

http://download.oracle.com/docs/cd/E13160-01/wli/docs10gr3/upgrade/index.html
http://download.oracle.com/docs/cd/E13160-01/wli/docs10gr3/tptutorial/index.html
http://download.oracle.com/docs/cd/E13160-01/wli/docs10gr3/upgradetutorial/index.html
http://download.oracle.com/docs/cd/E13160-01/wli/docs10gr3/upgradetutorial/index.html
http://download.oracle.com/docs/cd/E13160-01/wli/docs10gr3/jpdtutorial/index.html
http://download.oracle.com/docs/cd/E13160-01/wli/docs10gr3/dttutorial/index.html
http://download.oracle.com/docs/cd/E13160-01/wli/docs10gr3/worklisttutorial/index.html
http://download.oracle.com/docs/cd/E12840_01/wlw/docs103/guide/introduction/conWorkshopTutorials.html


C H A P T E R 2
Known Limitations
This section describes known limitations in the Oracle WebLogic Integration 10g Release 3 
(10.3) release. The known limitations are grouped by the following topics:

Administration, Configuration, and Worklist Application

Business Process

Cluster Configurations

Controls

Event Generators

Data Transformation

Trading Partner Integration

Upgrading Oracle WebLogic Integration
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Administration, Configuration, and Worklist Application

Problem ID Description

CR382645 During domain configuration using the Oracle WebLogic Configuration Wizard, in the Run 
Database Scripts window, Oracle 11g database is not shown as a DB Version option when 
you select any Oracle data source. 

Workaround: Since the SQL scripts are the same, you can select Oracle 10g database option 
and run the database scripts against the Oracle 11g database.

CR378785 User name is not validated when you try to assign a user while creating /updating a 
Worklist task plan.

Workaround: Make sure that you do not use any invalid characters like @, $, etc. for a user 
name.
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Admin is t rat ion ,  Conf igurat ion ,  and  Work l i s t  App l i cat ion
CR362278 worklistEvent channel can not be selected from static message broker subscription 
control.

Workaround: Create a JPD, select 'Subscribe to a Message Broker channel and start via an 
event', go to source view and update:
@com.bea.wli.control.broker.MessageBroker.StaticSubscription( 
xquery = “”, filterValueMatch = “”, channelName = “”, messageBody 
= “{x0}”)  
public void subscription(org.apache.xmlbeans.XmlObject x0) { 

with:
@com.bea.wli.control.broker.MessageBroker.StaticSubscription( 
xquery = "", filterValueMatch = "", channelName = 
"/WorklistEvent", messageBody = "{x0}", messageMetaData = "{x1}")

public void subscription(com.bea.data.RawData x0, 
com.bea.wli.worklist.xml.TaskEventMetadataDocument x1) {

Save the JPD, build, and return to the Design view of message broker control, select filter, 
and proceed.

Note:

If you still face any issue just make sure you have the XQuery annotation in the subscription 
JPD as follows:
@com.bea.wli.common.XQuery(prolog='declare namespace ns0 = 
\'http://www.bea.com/wli/worklist/xml%5c';')

Place the XQuery annotation before the @com.bea.wli.jpd.Process(process = 
annotation. 

CR353849 When configuring a WLI domain with Domain Configuration Wizard and choosing MS 
SQL 2005 as database from the drop-down list in the Run Database Scripts window, the 
script for the p13nDataSource is not displayed

Workaround:Select 2000 as the DB Version in the drop-down list for the p13nDataSource 
and run the scripts against MS SQL 2005. The domain will work fine with MS SQL 2005 as 
the DB scripts are the same for MS SQL 2000 and MS SQL 2005.

This problem does not occur when a domain is created for WLI and WebLogic Portal.

Problem ID Description
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CR349800, 
CR379251, 
CR382286

When installing Oracle WebLogic Integration, WebLogic Server, Workshop for 
WebLogic, and WebLogic Integration need to be installed in the same BEA HOME and 
the default names for WebLogic Server directory, Workshop for WebLogic directory, 
and WebLogic Integration directory must not be changed. Otherwise the installation 
will not work.

Workaround: Install WebLogic Server, Workshop for WebLogic, and WebLogic 
Integration together in the same BEA_HOME. The WebLogic Server directory should be 
'%BEA_HOME%/wlserver_10.3', the Workshop for WebLogic directory should be 
%BEA_HOME%/workshop_10.3 and WebLogic Integration directory should be 
'%BEA_HOME%/wli_10.3' where BEA_HOME is the location where the product is 
installed.

CR300337 When JWS invokes JPD, the callback to JWS from a JPD fails in a cluster.

Workaround: The com.bea.control.annotations.MessageBuffer must not be 
used on the callback operations of a Process control that is used to invoke a JPD from a JWS. 
Using the com.bea.control.annotations.MessageBuffer annotation will not 
work reliably in a cluster environment.

CR300140 While editing a newly created event subscriptions of a worklist instance, two Edits 
interfere each other. 

Workaround: Delete the event subscription that is created, and re-create it. Enter all the 
values you wish to add for the new subscription in the Add Subcription page itself as the two 
edit links interfere with each other.

CR299266 After application source upgrade, MFL Transformation failed with XQuery Exception 
(XQRLUserException).

Unlike in 8.x, the 10.2 MFL-derived XMLBeans belong to a namespace. So, the upgraded 
XQuery transformations that use MFL-derived XMLBeans as output types must be manually 
updated to yield XML with elements in the appropriate namespace. The namespace used is 
determined by the path of the MFL file, relative to the schema source directory. 

For example, an MFL file located at project/schemas/dir/purchase.mfl will yield 
XMLBeans that belong to the XML namespace: dir/purchase.

CR296394 The user portal displays default values that are actually not in the database. If you 
accept these values, they are inserted into the database. 

These are populated with default values to reduce work for the user to work on user portal.

CR295076 You might encounter a database deadlock with Worklist applications if you have 
configured your domain with DB2. 

Workaround: There is no known workaround at this point.

Problem ID Description
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Admin is t rat ion ,  Conf igurat ion ,  and  Work l i s t  App l i cat ion
CR292434 Potential database deadlock when using Microsoft SQL. 

You might encounter a database deadlock if you have configured your domain with Microsoft 
SQL. 

Workaround: After you have created your domain, modify the datasource scripts to add the 
“SendStringParametersAsUnicode=false” property. 

CR290980

CR295210

Issues due to WebLogic Portal 10.2 template patches.

When you create a Platform-like by adding wlp.jar template onto a WLI domain, with 
express mode or user explicitly selecting run DB script, loadDB fails when extending 
wlp.jar and the domain does not start. 

Workaround: Using the Configuration Wizard tool, create a Platform-like domain by 
adding WebLogic Integration templates to a WebLogic Portal domain, or by selecting the 
WebLogic Portal and WebLogic Integration check-boxes.

--------------------

When you create a Platform-like by adding the WebLogic Portal component onto a WebLogic 
Integration domain, with express mode or user explicitly selecting run DB script, loadDB fails 
when extending wlp.jar and the domain does not start.

Workaround: There is no workaround for this problem.

--------------------

When you create a WebLogic Portal domain by extending workshop_wl.jar, p13n.jar 
and wlp.jar templates, one template at a time, with express mode or user explicitly 
selecting run DB script, loadDB fails when extending wlp.jar and the domain does not 
start.

Workaround: Select the WebLogic Portal checkbox to create the Portal domain.

--------------------

When you create a WebLogic Portal domain by extending workshop_wl.jar, p13n.jar 
and wlp.jar templates, one template at a time, with loadDB() invoked each time extending 
a template, loadDB fails when extending wlp.jar and the domain does not start.

Workaround: Extend the required templates together and invoke loadDB() explicitly in the 
WLST script. 

--------------------

When you create a WebLogic Portal domain by extending workshop_wl.jar, p13n.jar 
and wlp.jar templates together, without explicitly invoking loadDB(), the resulting 
domain fails to start because of missing tables.

Workaround: You need to explicitly invoke loadDB().

Problem ID Description
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CR293975 WebLogic Integration 10.x domains take longer to start up when compared with 
WebLogic Integration 8.x domains.

The problem has been mitigated by removing extra backward compatibility resources from 
newly created WebLogic Integration domains. Newly created domains will not deploy 
backward compatibility resources (applications, etc.) and will thus boot more rapidly than if 
those resources were present in the domain. 

Note: Even with this change, the boot time for 10.2 domains is somewhat longer 
than a comparable 8.x domain. This is due to more sophisticated application 
structure and deployment needs in 10.2.

If you wish to create a new domain and also add backward compatibility support to that 
domain, you must create the WebLogic Integration domain, and then extend that domain with 
the wli_worklist81x extension template (using the configuration wizard).

WebLogic Integration 8.1.x domains that are upgraded to 10.2 will *automatically* have 
backward compatibility support added to them. No further customer action is required.

CR298397 If your application enables message buffering on controls or web services using the 
annotations com.bea.control.annotations.MessageBuffer or 
weblogic.jws.MessageBuffer, the following error is displayed when you try to 
deploy it on a cluster:

"While attempting to create destination MSG_BUFFER_QUEUE in module 
<name_of_your_ear>!WlwRuntimeAppScopedJMS the JMSServer of name 
<name_of_your_cluster> could not be found".

Workaround: In this case, you must target the MSG_BUFFER_QUEUE to a specific JMS 
Server with the following submoduletargets option to your weblogic.Deployer command: 
-submoduletargets 
cgJMSServer@WlwRuntimeAppScopedJMS@WseeJmsServer_auto_1.

CR291534 Any new task plan, by default does not have a create policy for any user: this has to be 
done explicitly through the worklist console. If this policy is not configured, then the 
JPDs’ that create tasks and are initiated through the JPD test console fail: This is 
because the JPD test console invokes the JPDs’ without any authentication and the JPD 
is run without any principal, thus as 'Anonymous'.

Workaround: You need to change the create policy and remove the <Anonymous>. By 
default <Anonymous> is added to the Global Task Plan Create policy. Thus, a task can be 
created Out of the Box by anyone.

Problem ID Description
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Admin is t rat ion ,  Conf igurat ion ,  and  Work l i s t  App l i cat ion
CR289425 Warning and Debug messages are displayed while starting the Out-of-the-box 
Integration domain.

Workaround: The administrator, in a production mode, must set a test table depending on 
the chosen database - for the databases supported by WLI.

CR288712 

CR288827 

You will get an exception when you try to extend any portal-enabled domain with the 
WSRP template (wsrp-simple-producer.jar) either using the Configuration 
Wizard or WLST offline. 

CR288966 Exception message displayed in the purging tasks of Worklist application.

Based on the permissions you have, you can perform the purge action. An exception message 
is displayed when the tasks are of type “Compat 8.1.x”.

<Anonymous> users can purge 8.x Compat Tasks.

CR283676 When you enter a custom User Interface page for the first time in a browser session, a 
blank page is displayed.

Workaround: You need to refresh your browser to view the custom User Interface page.The 
usage of an incorrect case in the task-ui-registry.xml entries can cause the related 
custom task page to appear blank for the first time, and is then displayed after the page is 
refreshed.

CR283190 The Managed Server does not start unless the Administration Server already running.

Workaround: None.

CR272488 Exceptions are encountered in the Server Console when using the Worklist Sample 
Application.

While working on the Worklist Sample Application through the Worklist User Portal, you 
may encounter org.apache.beehive.netui.util type exceptions in the Server 
Console. You can ignore the exceptions displayed in the Server Console as they are not very 
critical.

CR270149 The Pointbase database throws an error if the amount of data received exceeds the 
database size of 30MB.

Workaround: You can use the WLI Administration Console (System > Purge > Purge 
Tracking Data) to manually purge the data from the tracking table. You can alternatively 
reduce the tracking level for this process type, if the tracking data is not being used. For more 
information, see Managing Process Tracking Data in Process Configuration in Using the 
WebLogic Integration Administration Console.

Problem ID Description
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CR268925 Unauthorized users (users who do not have Administration/Update/Query rights, or 
claimant, assignee rights) can see the built-in and user-defined properties of a task. This 
can happen when a control callback or TaskEventListener delivers a TaskEvent 
containing this information.

Workaround: Asynchronous events still have user properties as ChangedProperty 
instances (each containing a PropertyInstance with a name, type, and so on.) on them, but the 
property values equals to null. For system properties, they receive a ChangedProperty 
instance with a name, but the value is equal to null.

CR180096 Security Configuration Dependency on web.xml 

Do not use the WebLogic Integration Administration Console to access your business process 
to secure SOAP-HTTP access to your business process if you have already secured your 
business process using the security-constraint element in the web.xml deployment 
descriptor and the @common:security annotation. You will receive a security violation at 
run time. 

CR156713 Result of trackdata() Call Not Recorded For Large Documents on Transaction Rollback 

To avoid a possible problem in subsequent archiving, if both of the following conditions are 
met, the result of a trackdata() call will not be recorded in the WebLogic Integration 
process events table. 
• The transaction that calls JpdContext.trackData(XmlObject value) or 

JpdContext.trackData(RawData value) is rolled back. 
• The document passed in is large enough to be stored in the SQL document store. 

Note: A document is persisted to the document store if it exceeds the size specified by the 
weblogic.wli.DocumentMaxInlineSize property in the 
wli-config.properties file. For example, the property is set as follows in the 
sample integration domain:  
 
# Minimum size for documents stored in the SQL Document 
Store:  
 
weblogic.wli.DocumentMaxInlineSize=524288 

Workaround: To minimize the risk of trackData calls being affected by a process 
rollback, call trackData() in its own transaction (in a perform node encapsulated within 
an explicit transaction boundary). 

Problem ID Description
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Admin is t rat ion ,  Conf igurat ion ,  and  Work l i s t  App l i cat ion
CR104868 A rewrite of an internal code generation framework for R27.4 has eliminated known 
bugs causing JRockit to crash.

Running Business Processes 

You must build applications that use WebLogic Integration functionality in a WebLogic Integration or 
WebLogic Platform domain. Running business processes and data transformations in a WebLogic Workshop 
domain is not supported. 

Problem ID Description
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Business Process

Problem ID Description 

CR382068 While accessing the process information from the Oracle WebLogic Integration 
Administration Console after a process instance is terminated, the Could not resolve 
connection: could not use local transaction commit in a global 
transaction java.sql.SQLException: could not use local 
transaction commit in a global transaction exception may occur. 

Workaround: Set the value of the test-connections-on-reserve data source 
property to true in the DOMAIN_HOME\config\jdbc\cgDataSource-jdbc.xml file 
as shown below: 
<jdbc-connection-pool-params>

<test-connections-on-reserve>true</test-connections-on-reserve>

<seconds-to-trust-an-idle-pool-connection>0</seconds-to-trust-an
-idle-pool-connection>

</jdbc-connection-pool-params>

To set the property value to true from Oracle WebLogic Server Console, in the Domain 
Structure pane, click Services > JDBC > Data Sources. In the Summary of JDBC Data 
Sources page, click cgDataSource. In the Settings for cgDataSource page, click Connection 
Pool and click Advanced. Select the Test Connections On Reserve check box and set the 
value of Seconds to Trust an Idle Pool Connection to 0 and save the configuration for the 
data source's connection pool.

CR379835 Integration sample domains are now located in the 
<BEA_HOME>/wli_10.3/samples/domains/integration directory and are no longer 
created in the <BEA_HOME>/wlserver_10.3/samples/domains/integration directory.

CR378545 When a WLI process accesses a service via the Service control, and the "Show in Service 
Assembly Modeler" option is selected, the Service Assembly Model does not show a 
reference to the service in the IDE.

Workaround: Copy the WSDL to the same folder as the service control and edit the schema 
location in the WSDL to point to the absolute path of the schema.
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Bus iness  Process
CR374511 Unable to see JPD configuration pane in default Process perspective.

Properties view and JPD Configuration view can not be used together in the Process 
perspective. 

Workaround: To modify values in the JPD Configuration pane, you need to first close the 
Properties pane and then open the JPD Configuration pane (in Oracle Workshop for 
WebLogic IDE, select Windows menu > Show View > Other > General > JPD 
Configuration) and reload the JPD. To return to the Properties pane, close the JPD 
Configuration pane, open the Properties pane and reload the JPD. 

CR361300 When a WSDL is generated from a WLI JPD that references XmlBeans whose schema 
reside in another WSDL file, then the generated WSDL only refers the namespace, but 
does not include the schema types from the original WSDL. This can for example 
happen when an ALDSP WSDL is imported into the WLI project.

Workaround: This problem has two workaround solutions as follows:

Approach 1  - after generating the WSDL from JPD

After generating the JPD WSDL, copy the schema from the types section in original WSDL 
and insert that schema to the generated JPD WSDL's types section.

Approach 2 - when consuming the ALDSP WSDL

Segregate the types section from the original WSDL into an separate XML schema and 
reference that XML schema from within the original WSDL before importing it into the 
project.

CR360740 When a JpdProxy ant task is used for creating a JpdProxy jar file, it throws the 
following exception stack trace: 

[jpd-proxy-client-jar] Unmarshaller failed: com.bea.xml.XmlException: failed  to load java 
type corresponding to t=applicationType@http://java.sun.com/ xml/ns/j2ee.

CR360300 If you import a WSDL for a service in Workshop Studio by using the URI Service 
Resource and the system fails to download the WSDL for any reason (including invalid 
URL), no error message is displayed. 

Workaround: If a WSDL is not downloaded, you must confirm that the URI is valid by 
attempting to download the WSDL using a web browser. 

Problem ID Description 
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CR358616 Compile time error appears, when you create a process from a Service control or ALSB 
control, using the XMLBeans option.

Workaround: Do the following:
• If the WSDL has types, and there is no corresponding schema for those types, then copy 

the WSDL in to Schemas folder of the process project before generating Service Control 
or ALSB Control.

• If the WSDL has types and there is a corresponding schema for those types, then copy 
that schema in to the schemas folder of the process project before generating the Service 
Control/ALSB Control.

CR352960 Deployment of the process application fails in windows based OS environment if both 
the XMLBeans and JAX-RPC types are present for the same schema in the project. 
java.lang.NoClassDefFoundError for the type class is displayed on the WLS 
console, even though the class exists in one of the jar files existing in the project. This 
happens when using the Service control/ALSB control.

Workaround: When generating the service control for the given WSDL, it is recommended 
either to use XML Beans or JAX-RPC types. Do not use them at the same time. 

For example, if the WSDL has types section, or if the WSDL is placed in the schemas folder 
of the web/util project and we generate service control out of that WSDL with JAX-RPC 
types, then both XMLBeans and JAX-RPC types will present in the application and as a result 
the deployment would fail.

CR343940 If you create a WSDL from a WLI JPD (right-click on JPD -> Generate -> WSDL) and 
you validate that WSDL (right-click on WSDL -> Validate), the validation might throw 
an error.

Workaround: Don't validate the WSDL by right-click -> Validate. The build handles the 
WSDL validation.

CR335624 When using the BEA Workspace Studio Internal Web Browser to test a WLI JPD (Run 
As > Run on Server) and clicking on the Process Graph tab, an empty screen is 
displayed. This only happens if the Adobe SVG viewer is not installed.

Workaround: The Process Graph view works with all other external browsers. You can set 
the external web browser in Workshop Studio as follows:
1. Click on the main menu in BEA Workshop Studio.
2. Go to the web browser sub menu.
3. Select an external browser such as Internet Explorer or Firefox. You will now be able to 

view the process graph.

Problem ID Description 
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Bus iness  Process
CR326895 A PersistenceException occurs when passing ebXML messages

A PersistenceException occurs when passing ebXML messages with binary attachments 
between two B2B applications, if the documentmaxinlinesize parameter in the 
wliconfig.properties file is set to the default value. 

Workaround: Set the documentmaxinlinesize value to 2.5 times higher than the data 
size.

CR298911 Endless timeout events getting displayed in Test console.

Workaround: The feature works as designed. This is a general expected behavior of all non 
WLI controls. The external controls are not frozen or suspended with the JPD.

CR298097 The browsing feature does not work for JPDs.

Workaround: In the EAR deployment mode, the test browser allows you to browse inside 
the war file. However, you cannot open or read the actual files. In the split source mode, no 
files are displayed as the war is empty. It is not possible to reset the status of a process from 
within the test browser.

CR297020 When trying to print a WLI JPD from the Process Perspective design view on a Linux 
platform, the Print dialog box is not displayed.

Workaround: None, this problem occurs due to an Eclipse platform limitation.

CR292400 In WLI 10.2, while generating a Process Control and Fronting JWS, empty conversation 
finish method is generated.

Workaround: Works as designed. The reason, the conversation is seen when the Process 
Control is generated is due to the fact that there is additional node (perform) after the 
clientRequestWithReturn node. It is recommended to create other client visible nodes 
(conversation continue) after the clientRequestWithReturn node and then start the 
conversation annotation on the process control. Remove the perform node after the 
clientRequestWithReturn and the conversation start annotation on the process control 
is not seen. When the process control has a conversation annotation, the generated JWS will 
have a place holder conversationFinish method giving the client ability to finish the 
conversation. In this case, the client must call the conversationFinish to finish the 
conversation. This restriction will not be present once the JWS front end feature is enhanced 
so that the conversation on the JWS is finished implicitly when the JPD conversation 
completes.

Problem ID Description 
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CR287671 The package names of MFL xbean types are derived from MFL file paths, relative to the 
schemas directory.

For example, types for an MFL file foo/BAR.mfl would live in a package foo.bar.

But, if the MFL file contains an alphabet which occurs after a number, the case of the alphabet 
changes to upper case. Also, the letter after a hyphen character changes to upper case. 
Examples: 
• a file /foo/foo2bar.mfl will result in a package name of foo.foo2Bar
• a file /foo/foo-bar.mfl will result in a package name of foo.foo-Bar

This affects upgrade scenarios where the user has:
• MFL files named in such a manner and
• files (e.g. processes) which reference xbean types generated from the MFL files.

Workaround: You need to update the references to use the 10.2 style package names.

CR284937 Test console Displays Comments in the JPD

When you use the test console to test an application that you have upgraded from 8.1 to 10.2, 
you may see comments annotated as follows in the Test console:
"/** * @jpd:process process:: ....." 

You can ignore these comments—the upgraded JPD contains the original (8.1) process 
annotations as comments and these are displayed in 10.2. 

CR279454 Dynamically Propagate Changes in a JPD to the Control and WSDL files 

Unlike in 8.1, changes made to a JPD in 10.2 are not automatically reflected in its 
corresponding Control or WSDL files. 

Workaround: If any changes are made in a JPD, you must regenerate the Control and WSDL 
files to reflect these changes. 

Problem ID Description 
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Bus iness  Process
CR275878 Renaming the default Web Content folder (Webcontent) in a Web Project. 

Renaming the default "Webcontent" folder in a Web Project would cause problems when the 
project is compiled or run. This is because the new name does not reflect in all the settings 
files that references it. 

Workaround: To successfully change the Webcontent folder name, you have to ensure that 
the new name is updated in the following documents: 
• {webProject}/.settings/org.eclipse.wst.common.component
• {webProject}/.settings/org.eclipse.jdt.apt.core.prefs

Open the Navigator view by clicking Window ->Show View -> Navigator. You will see a File 
explorer view that shows all the folders, including the hidden folders. In the Navigator view, 
expand the Web Project. You will see the .settings folder. Under the .settings folder, you will 
see the org.eclipse.jdt.apt.core.prefs file and the org.eclipse.wst.common.component file. 
Make sure that the new Web Content folder name is set correctly in those two files.

CR245676 Eclipse problems viewer which lists all the diagnostics in a JPD is displayed in the 
Design view. 

You can use the Design view to find the source of the error.

CR206655 ProcessRuntimeMBean Failing to Retrieve Stateless Business Process Instance 
Information in Development Mode 

The ProcessRuntimeMBean is not normally used for stateless business processes. It is 
usually used for stateful processes. In development mode, not production mode, on some 
processes, it may return the wrong information. 

CR200072 Uncommitted Local Transaction when Connection Returned to Connection Pool 

The local transaction is left open. To close it, in the JDBCConnectionPoolMBean, set the 
property RollbackLocalTxUponConnClose="true". 

Problem ID Description 
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Cluster Configurations

Problem ID Description

CR182788 After performing JTA and JMS migrations from a failed managed server, a process 
instance may remain in running mode.

 A repeating set of error messages similar to the following appears in db2diag.log: 

Instance:DB2 Node:000 
PID:3888(db2syscs.exe) TID:5400 Appid:/1721616.3366.00090031001F 
data protection sqlpxTEntrySwitchIn Probe:300 Database:DBNAME 
 
DIA8036C XA error with request type of "". Transaction was not 
found. 
ZRC=0x80100024. 

 CR156912 Deploying an EAR in Cluster Configurations Causes Certain Warnings That Can Be 
Ignored 

Specifying a cluster name as the target when you deploy an EAR file causes BEA-149055 
warnings to appear in the WebLogic Server console window for the WebLogic Server that 
hosts the WebLogic Server Administration console (WebLogic Administration Server). These 
warnings include the following text: 
Having multiple individual servers of a cluster as targets instead 
of having the entire cluster as the target can result in 
non-optimal load balancing and scalability. 

You can ignore these messages. 
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Cont ro ls
Controls

Problem ID Description 

CR359934 Using JRockit 5.0 R27.3.1 and dynamic selectors in a Service Broker Control might 
cause problems.

Workaround: Use JRockit 5.0 R27.4.0 and higher releases with the Dynamic control 
selector.

Note: The (Dynamic) Selector has been deprecated. Please use the XML Meta 
Data Cache Control instead.

The XML Meta Data Cache can be used to store configuration information to be retrieved at 
run-time and set to a control dynamically. For more information, see XML Meta Data Cache 
control.

CR352733 When an ALSB Transport Control/EJB control with transaction propagation is used in 
the exception path of a WLI JPD, the exception path is configured with “execute on 
rollback” and when that transaction is marked for rollback by the external entity (the 
ALSB server or the EJB), the process aborts.

Workaround: The transaction must not be marked for rollback, but it must allow to throw an 
exception that can be handled by the process.

CR335407 A BindingsCheckException is thrown from the ALSB Transport control wizard when a 
WSDL is used to create a ALSB Transport control.

Workaround: Update the patch profile in the IDE. For details, see Enabling Runtime 
(Server) Patches. 

After the patch update, use the WSDL to successfully create the ALSB Transport control. You 
must restart Workspace Studio after updating the patch profile.

CR300356 The change in the Workshop Time control behavior from 8.1 to 10.2 causes problem 
when the control is used from JPD.

Workaround: WliTimerControl is the default WebLogic Integration timer control for JPDs. 
There is limited support for the WLW Timer Control when used from a JPD.
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Event Generators

Problem ID Description

CR383232 You may encounter some of the following errors if your domain's cgDataSource is configured 
to use Oracle's Driver (Thin XA):
• Exception when you create a channel rule for a Timer event generator : 

javax.management.MBeanException: 
com.bea.wli.calendar.api.BusinessCalendarException: [WLI-Calendar:492000] An error 
occurred during business calendar operation"

• “Exception encountered" error when you delete the Timer event generator 
• Timer event generator may be running but it may not deliver events to the channels

In all the above cases, you will see the following exception in the server log:
java.sql.SQLException: XA error: XAResource.XAER_PROTO start() 
failed on resource 'cgDataSource': XAER_PROTO : Routine was 
invoked in an inproper context

Workaround: Set the value of the test-connections-on-reserve data source 
property to true in the DOMAIN_HOME\config\jdbc\cgDataSource-jdbc.xml file 
as shown below: 
<jdbc-connection-pool-params>

<test-connections-on-reserve>true</test-connections-on-reserve>

<seconds-to-trust-an-idle-pool-connection>0</seconds-to-trust-an
-idle-pool-connection>

</jdbc-connection-pool-params>

To set the property value to true from Oracle WebLogic Server Console, in the Domain 
Structure pane, click Services > JDBC > Data Sources. In the Summary of JDBC Data 
Sources page, click cgDataSource. In the Settings for cgDataSource page, click Connection 
Pool and click Advanced. Select the Test Connections On Reserve check box and set the 
value of Seconds to Trust an Idle Pool Connection to 0 and save the configuration for the 
data source's connection pool. 

CR327768 If the WLI database goes offline and is brought online again, Event Generators might 
not function as expected anymore. Suspending and resuming the Event Generators 
using the Administration Console will most likely not be enough.

Workaround: After restarting the domain and the server, the Event Generators will work as 
expected again.
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Event  Generato rs
CR345114 TIBCO anticipated listeners are not supported in WLI. When a WLI JPD with a 
TIBCO RV Control uses anticipated listeners to send the message to a destination, and 
a TIBCO RV event generator for that listener is only deployed afterwards, the event 
generator is not able to receive the messages in the configured timeout for Certified 
Messaging.

Workaround: Deploy the event generator before the process, and then let the process send 
the messages to the required destinations.

CR289678 A SQL Exception can occur when you create an RDBMS Event Generator on a table 
that has LONG column(s) (Oracle Database). 

Workaround: Change the table to use LOB instead of LONG. 

CR276975 Creating a New TIBCORV Event Generator with a blank space through WebLogic 
Integration Administration Console throws javax.servlet.ServletException: 
jndi lookup failure for TIBCO Event Generator.

Workaround: Event Generator names should not have any spaces in between.

CR206549 

CR206332 

Slow Down of Sybase Database Table or Microsoft SQL Table When Using RDBMS 
Event Generator 

When a Trigger Type event is created on a Sybase Table or Microsoft SQL Table, the 
RDBMS Event Generator creates a Shadow table that is a replica or subset of the User’s 
Table. The Trigger copies the Inserted, Deleted, and Updated rows from the User Table into 
the Shadow Table. As the rate at which rows are inserted, deleted, or updated into the User 
table increase beyond the rate at which the event generator can poll and process rows, the new 
rows become backlogged and cause the Poll query to slow down. 

Workaround: The Shadow table gets created with the same name as the Channel Rule 
Definition name with an _BEA_SDW suffix. To speed up polling and hence processing, a 
Unique Index must be created on a particular column. For example, if the Trigger Event name 
(Channel Rule Definition name) is hello123, the Shadow Table gets created as 
hello123_BEA_SDW. To workaround this problem, create a Unique Index as follows: 

CREATE UNIQUE INDEX [idx_hello123] ON  
schema_name.hello123_BEA_SDW(BEA_SEQ_ID) 

CR206519 Timer Event Generator May Not Reflect Changes in Business Calendar 

After making a change to the Business Calendar, the Timer Event Generator may not pick up 
the change in the calendar. 

Workaround: In the WebLogic Integration Administration Console→Event 
Generators→View All File Event Generators window, select the appropriate Timer Event 
Generator, click Suspend, and then click Resume. 

Problem ID Description
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CR205996 RDBMS Event Generator Trigger Not Deleted For Certain Trigger Type Events 
created on Microsoft SQL Server 

When creating a Trigger Type Event on a schema other than with the DBO username, the SQL 
Server creates the Trigger in the same schema as the User Table on which it was created. If 
there is an attempt to insert rows after the Event has been deleted, errors are thrown because 
the Trigger still exists. Creating the Trigger does not require a schema name prefix but 
dropping the Trigger requires a schema to be prefixed to the statement. 

Workaround: After the Event is deleted, the Trigger must be dropped manually using a 
simple command DROP TRIGGER <user_table_schema_name>.<trigger_name>. 

CR204272 Enabling Auto Commit for RDBMS Event Generators when Working with Informix 
Databases 

If you are working with an Informix database, you should always enable the auto commit 
mode during an Insert, Update, or Delete event. 

CR202902 Automatic Delete for Query or Post Query Events in RDBMS Events 

In the case of an Query or Post Query Events query with automatic delete (nothing specified 
in Post Query), the Max Rows Per Poll value is ignored. This was tried with values of 1 and 
10 for Max Rows per poll. But in each case, all the rows were published and deleted in one 
single poll instead of 1 or 10 per poll as specified in the Channel rule definition. 

This case is specific to the Sybase database when using the Data Direct driver. 

In Oracle 9i DB with Oracle's 9i Thin Driver, the behavior was as expected and only 1 or 10 
rows were published as specified in the channel rule definition. 

In DB2 and Informix, the automatic delete option is not supported. 

CR201132 Creating Triggers on a Sybase Database Table 

If you are working with a Sybase database, when a Trigger Event is created on a Sybase table 
that already has one Trigger Event of the same type, such as Insert, configured, the older 
Trigger is replaced. This means that the older Trigger Event stops working. 

You can have one Insert, one Delete and one Update Trigger Event per Sybase Table. 

CR200743 Correct Data Not Published for Informix Database Triggers with Different Data Types 

Due to the fact that Informix databases have peculiar ways of retrieving the Precision and 
Scale of DECIMAL and MONEY data types, it is recommended that you specify the Precision 
and Scale in the User Table - DECIMAL(p,s). 

Problem ID Description
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CR200681 Restrictions on Trigger Type Events Created on Informix Databases 

Trigger type events created on Informix databases have some restrictions. The value specified 
in the No. of Threads field and Max Rows Per Poll field must always be 1 and the value 
specified in the Polling Interval field must be greater than the total time it takes to publish 
the rows picked up in every poll. 

CR200495 Creating New RDBMS Event Generator Channel Rule Definitions in Informix 
Databases 

If you are working with an Informix database and you want to delete an existing channel rule 
and create a new channel rule with the same name as the one you just deleted, you must set 
the Statement Cache size to zero. 

CR196414 File Event Generator FTP Supports Only Windows and UNIX Type FTP Servers 

Only Windows and UNIX type FTP servers are supported by the File Event Generator FTP. 
VMS is not supported. 

CR196088 Using the RDBMS Event Generator in a Cluster 

To use the RDBMS Event Generator in a cluster, the managed nodes must be created 
with specific IP addresses and port numbers. By default, the IP addresses of the 
managed nodes are null. If the default settings are used, events cannot be created in 
RDBMS Event Generator. IP Addresses and Port Numbers of the Managed Nodes 
must be provided. 

Additionally, the Administration server sends messages to the distributed queue, 
Because the distributed queue is available only on the managed nodes, the 
JNDI-scoped security for wli.internal.egrdbms.queue must have lookup 
access to the default group: Everyone. BEA recommends always using the default 
security policies for administrative and server resources. 

Problem ID Description
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CR186350 Setting Event Generator Polling Interval for Configuration Changes 

The polling interval of the Event Generators may be set to a user-defined interval by using the 
following Java system properties:
• Email: wli.eventgen.email.checkConfigDelay 
• File: wli.eventgen.file.checkConfigDelay 

• Timer: wli.eventgen.timer.checkConfigDelay 

These properties may be set on the Java command that starts the server. Each property sets 
the number of milliseconds between polls. For example: 

-Dwli.eventgen.timer.checkConfigDelay=30000 

This sets the Timer Event Generator polling for configuration changes every 30 seconds. 

If not specified, the default polling interval of 10 seconds is used. 

CR138802 Retrieving or Filtering on Timer Event Generator Metadata with Channel Type of 
XML is Not Supported 

Events published by the Timer event generator with channel type of XML do not contain 
metadata headers, consequently, filtering or retrieving events based on metadata is not 
supported at this time. 

Using the RDBMS Event Generator to Publish String or XML Type Channels 

If you configure events to publish to a String or XML type channel, the published results will contain a 
RowState attribute similar to the following: <TableRow wId:RowId="2" 
wld:RowState="Inserted">. The RowState attribute will always be “Inserted”, even if the event type is 
“Deleted” or “Update”. You should ignore this attribute as it does not indicate that the Row was inserted. 

RDBMS Event Generator Data Loss 

If the WebLogic Workshop application containing the channels to which the RDBMS Event Generator is 
publishing events is undeployed while the event is publishing data, or if the JDBC Store/Database used for JMS 
fails, but the database on which the event is configured is still running, there is a possibility of some data being 
lost. To minimize this possibility, the Rows allocated Per Poll to each Processing Thread should be a small 
number (around 50 or lesser). This number can be calculated as follows; Max Rows Per Poll/No. Of Processing 
Threads = Rows Per Processing Thread. 

RDBMS Event Generator Channel Rule Definition 

When you are creating channel rule definitions in the WebLogic Integration Administration Console, it is 
recommended that you do not use the Back button if you want to resubmit the details on a page. You should 
always use the navigation links provided and create a new channel rule definition. 

Problem ID Description
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Data Transformation

Problem ID Description

CR364742 Testing of a transformation involving multiple non-XML source schemas requires 
source data to be available for even unmapped schemas.

In a transformation file that has multiple non-XML source types (MFL), testing of the 
transformation requires data for all of the source types, even if some of them are not mapped 
to output types.

If data is not provided in the Test view for one or more of the source types, the following error 
message is displayed: The non XML data for parameter <parameter_name> 
could not be transformed into the appropriate XML data. Missing 
non optional data.

CR359928 XQuery mapping to <any> type target element is not retained.

When you create a link to an <any> type target element in the Design view of an XQuery 
transformation, the mapping is not reflected in the Source view. When you save and close the 
XQuery file, the mapping is also not retained in the Design view.

Workaround: Write the code for the transformation in the Source view.

CR358244 Nested for expression variables are not available for selection in the Design view for the 
peer and child clauses of the for expression.

When you create a nested for expression in an XQuery transformation, the corresponding 
for variable is not available for selection (in the Design view) for the peer and child clauses 
of that for expression. If you try to use the for variable by typing the variable name, an error 
message (Variable used but not declared) is displayed. You cannot use nested 
for variables while creating expressions in the Design view.

Workaround: You can use nested for variables expressions in the Source view and also 
execute the queries in the Test view. Note that after you create expressions that use nested 
for variables in the Source view, if you make any changes in the Design view, the error 
described above might occur again, requiring you to correct or rewrite the expression in the 
Source view.
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CR353320 While working with nested FLWOR expressions, Workshop might run out of resources.

While working with nested FLWOR expressions in XQuery transformations, when the 
For...Return pane of the Target Expression view is refreshed repeatedly (for example, when 
you switch continually between the Design and Source views), the SWTError:No more 
handle error might occur, indicating that Workshop has run out of resources.

Workaround: Close and restart Workshop.

CR297754 DND of Expression functions do not work on Linux.

If you open an XQ file, select a target element in the Design view, select a function in the 
Expression Functions view, and attempt to DND a function to a valid location, the function is 
not applied.

Workaround: You can drag and drop the function only when the mouse pointer icon changes 
to indicate a droppable mouse pointer.

CR297025 Intermittent problems with mapping a source element to a target element.

Drag and Drop in the Linux IDE sometimes does not function when you try to map a source 
element to a target element.

Workaround: Drag and drop the source element to the target element only when the mouse 
pointer icon changes to indicate a droppable mouse pointer.

CR287396 Strings that include spaces are not allowed in the XQuery Condition Editors 

In 8.1, you could create a condition in an XQuery Condition Editor that included a space in 
string values for the condition. However in 9.2, you must enclose such strings in single or 
double quotes. 

For example, in 8.1, a Decision Node with the following variable and string selected on the 
left and right hand sides of the builder, respectively, created a valid condition: 

(left hand side) variable: '$requestXML/ns0:shipAddress/@state' 

(right-hand side) string: New Jersey 

Condition Generated: data($requestXML/ns0:shipAddress/@state) = “New 
Jersey” 

Workaround: For 9.2, the XQuery Condition Editor requires that you enclose such strings 
in single or double quotes—use the following syntax for a string such as the one in the 
right-hand side of the condition builder example above. 

‘New Jersey’ or “New Jersey”

Problem ID Description
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CR252888 It is not possible to create a copy link in non-XML to XML and XML to non-XML data 
transformation.

The copy link is not created when mapping the source to the target element.

Workaround: Create a link between the parent source and target elements. Right-click on 
this link and select the Induce Map option.

CR223388 In the XQuery Transformation Test view, source data is not generated properly for 
recursive elements.

The generated data for a recursive element is empty in the Test view.

Workaround: Correct the generated data manually and then test the XQuery.

CR206671 Transformation Exception for In-Flight Processes when Shutting Down and Restarting 
Server 

If the server is shutdown while a business process transformation is running and restarted, a 
transformation exception is thrown. 

Workaround: Restart the business process. 

Problem ID Description
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CR206148 Message Format Error While Using MFL Non-XML to XML Transformation Method 
in Format Builder 

The delimiter of Group level causes the exception in Format Builder or run time. 

Workaround: Remove this delimiter.

CR182658 

CR138588 

Casting is Limited or Unsupported Between Some XML Schema Types and Java Types 
in Transformations 

During run time, the casting in transformations between the following types can be limited or 
unsupported: 
• Between different XML Schema types 
• Between Java types and XML Schema types 

For example, the casting is limited between the XML Schema type xs:double and XML 
Schema type xs:integer. The casting from a source xs:double to a target 
xs:integer in a transformation will be successful during run time if the source double 
value is equal to 8 but will fail if the source double value is equal to 8.5 or even 8.0. The 
casting between these XML Schema types is unlike the casting done between types in the Java 
or C language. 

The casting between the XML Schema type xs:date and the java.util.Date is 
unsupported and will fail during runtime because these two types are not equivalent. The 
XML Schema type xs:date contains only a date component and does not contain a time 
component while the java.util.Date Java class contains both a time and date 
component. 

Problem ID Description
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Trading Partner Integration

Problem ID Description

CR182302 Bulk Loader Utility is Not Compatible with XA Database Drivers 

Attempting to load data in the TPM repository with the Bulk Loader configured to use an XA 
database driver fails with the following error: No suitable driver. 

Workaround: Configure the Bulk Loader to use a non-XA driver, or load the data 
interactively using the WebLogic Integration Administration Console. 

For information about how to configure the Bulk Loader, see “Configuring the Bulk Loader 
Configuration File” in Using the Trading Partner Bulk Loader in Managing WebLogic 
Integration Solutions.

For information about how to load TPM data using the WebLogic Integration Administration 
Console, see “Importing Management Data” in Trading Partner Management in Using the 
WebLogic Integration Administration Console.

CR175845 Extraneous Error When Deleting a Certificate 

When deleting a certificate from the WebLogic Integration Administration Console, if you 
encounter the following error message, click Continue to dismiss it: 

Certificate with name cert_name does not exist for partner 
partner_name. 

Despite the error, when you click Continue, the certificate is deleted. 

Workaround: The error message can be disregarded. 

CR156555 WebLogic Administration Console Generated Client Certificates May Not Work for 
Two Way SSL Testing 

The “self-signed” client certificates that you can generate for testing purposes through the 
WebLogic Integration Console may not work for two way SSL configurations when client 
certificates are enforced on the server-side. 

Workaround: When you are testing two way SSL configurations, generate your test 
certificates by using other tools, such as OpenSSL. 
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CR155713 DOCTYPE is Not Preserved in XQuery Transformations 

XQuery transformation does not preserve the DOCTYPE element. 

Workaround: If you need the DOCTYPE element in further processing, add it back into your 
message by using the obj.documentProperties().setDoctypeSystemId in a 
Perform node following the transformation. An example of this is shown in the “Walkthrough 
of the Failure Notifier Business Process” section of the “Step 2: Open the PIP0A1: 
Notification of Failure Example” example under the “Tutorial Steps” heading of the Tutorial: 
Building RosettaNet Solutions

CR155685 Update Older Bulkloader XML Files when Using Signature Configurations 

This version of WebLogic Integration supports MD5, in addition to SHA1, as a digest 
algorithm option for RosettaNet. If you want to use signature configuration with older 
versions of bulkloader XML files, you need to add the following attribute to these files: 
• signature-digest-algorithm="MD5" valid values are MD5, SHA-1 or NONE. 

The signature-digest-algorithm attribute is optional. Its representation is a 
character string in the DBMS. If you do not specify a value when you import the older version 
of the XML file, the value is set to NONE. 

CR155614 Trading Partner Integration API Changes 

The following APIs have changed: 
• retrieveAllTradingPartner is now retrieveAllTradingPartners 
• retrieveAllAuthentication is now retrieveAllAuthentications 
• retrieveRosettaNetServiceBinding is now 

retrieveRosettaNetServiceDefaults 

Problem ID Description
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CR155423 The ebXML Protocol Uses the Remote Trading Partner’s Values for Retry Number, 
Retry Interval, and Persist Duration 

When you are using the ebXML protocol for Trading Partner messaging, the values used for 
Retry Number, Retry Interval, and Persist Duration are always the values of the remote 
trading partner, not the local Trading Partner. 

CR138262 Using Controls to Send Messages from Participant Business Processes is Not 
Recommended 

In WebLogic Integration, you use Trading Partner Integration controls to send messages from 
the initiator business process to the participant business process. However, in the participant 
business process it is recommended that you use Client Response nodes to handle outgoing 
business messages to the initiator. 

If you use controls in a participant business process, you may lose the message response 
signals, such as acknowledgments and error messages. If you need to use a control to send 
messages instead of using the recommended design pattern, place the control in a subprocess 
and invoke the subprocess from the participant process. 

Problem ID Description
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Upgrading Oracle WebLogic Integration

Problem ID Description

CR382153 Unable to connect to WLI Administration Console and Worklist Console after 
upgrading a 10.2 WLI and WebLogic Portal domain to Oracle WebLogic Integration 
10g Release 3 (10.3)

Workaround: Increase memory setting in setDomainEnv file as follows: 

set MEM_ARGS=-Xms256m -Xmx768m

set MEM_PERM_SIZE=-XX:PermSize=128m 

set MEM_MAX_PERM_SIZE=-XX:MaxPermSize=192m

CR382069 When creating a dynamic web project and trying to reference it to an existing EAR 
project that was upgraded from an 8.x application, this EAR project is not listed in the 
"EAR project name:" drop-down list. 

Workaround: When you add a dynamic web project to an upgraded application, select 
“WebLogic Web Project Facets with Beehive (10.3)” in the “Configurations” drop-down list. 

CR379971 Unable to upgrade 9.2 WebLogic Portal domain or WebLogic integration and 
WebLogic Portal domain to Oracle WebLogic Integration 10g Release 3 (10.3)

Workaround: Use the upgrade script located in WLPORTAL_HOME/common/bin

CR339724 A WLI 9.2 production domain that uses Sun JDK will use BEA JRockit when upgraded 
to WLI 10.2

Workaround: Before starting the server, set JAVA_VENDOR=Sun (or edit the 
setDomainEnv.cmd to add PRODUCTION_MODE=true after the set WL_HOME=.... line.). 
The logic of selecting jrockit/sun jdk in production mode is defined in 
~wlserver_10.0\common\bin\commEnv.cmd.

CR337692 Deployment of a WLI application with Web Service controls fails

Deployment of a WLI application fails after upgrading the WLI application with Web Service 
controls from 8.1.x to 10.2.

Workaround: Re-create the Web Service controls migrated to 10.2 and reference the newly 
created 10.2 controls in their upgraded processes to successfully deploy the upgraded 
application.
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CR300337 com.bea.control.annotations.MessageBuffer must not be used on the callback 
operations of a Process control that is used to invoke a JPD from a JWS. Using the 
com.bea.control.annotations.MessageBuffer annotation will not work reliably in a 
cluster environment. 

CR299266 After application source upgrade, MFL Transformation failed with XQuery Exception 
(XQRLUserException). 

In 10.2, MFL-derived XMLBeans belong to a namespace. In 8.x, XQuery transformations 
that use MFL-derived XMLBeans as output types must be manually updated to yield XML 
with elements in the appropriate namespace. The namespace used is determined by the path 
of the MFL file, relative to the schema source directory. 

For example, an MFL file located at project/schemas/dir/purchase.mfl will yield 
XMLBeans that belong to the XML namespace: dir/purchase. 

CR299154 The Upgraded Work List Application throws a ControlException in the upgraded 
Integration domain.

Workaround: The upgrade does not set the security policy when the default authenticator is 
used. If you use an authorization provider other than the default LDAP provider, you need to 
either check or set this security policy.

After you upgrade a WebLogic Integration 8.1 domain, you must set the security policies on 
the Compatibility 8.1.x Task Plan and allow the 'Anonymous' role in the Create Policy. Use 
the Worklist Administration Console (the default authorization provider) to set the Create 
Policy for the Compatibility 8.1.x task plan. If you are using a third-party authorizer, use the 
related third-party client tools to set the policy.

CR298097 The Platform application upgrade from 8.1 SP5 to 10.2 failed while building the 
Schemas (XML Beans). 

Workaround: None

CR296186 Inlined XQuery expressions that occur within process annotations are not updated after 
selecting the "Upgrade XQ2002 to XQ2004" option. 

Even if the "Upgrade XQ2002 to XQ2004" option is selected in the Upgrade Wizard, some 
inlined XQuery expressions that occur within process annotations are not updated. Like, the 
usage of the xf: function prefix is supposed to be replaced by the fn: function prefix. So, 
for example: 

<case name=\"Case\" value=\"xf:string($x)\"/> 

should be: 

<case name=\"Case\" value=\"fn:string($x)\"/> 

Workaround: Manually change the function prefix in the source view. 

Problem ID Description
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CR295456 The upgrade process allows the receive node 'method' to have a non-void return type.

In WLI 8.1, it was possible to have a synchronous JPD where the receive node method can 
have a non-void return type. If such a JPD is upgraded to WLI 10.2, the upgrade process does 
not check the return type, which leads to a compilation error.

Workaround: You can detect this error by parsing the process XML and checking the return 
type of the message. WebLogic Integration issues a warning/error message that the 8.x source 
is invalid.

Problem ID Description
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CR293073 Workshop Web Service Control generated in 8.1 SP4 with types selected to Java for a 
complex type array with rpc/encoded mapped the complex type array to anyType[ ] 
instead of the concrete type array. For example: 
<schema targetNamespace="urn:serviciosAdminNE" 
xmlns="http://www.w3.org/2001/XMLSchema";;>  
   <import 
namespace="http://schemas.xmlsoap.org/soap/encoding/";;/>  
    <complexType name="Aplicacion">  
      <sequence>  
         <element name="certificado" type="xsd:base64Binary"/>  
         <element name="descripcion" nillable="true" 
type="xsd:string"/>  
         <element name="idAplicacion" nillable="true" 
type="xsd:string"/>  
         <element name="nombre" nillable="true" 
type="xsd:string"/>  
         <element name="organismo" nillable="true" 
type="xsd:string"/>  
      </sequence>  
      </complexType>  
      <complexType name="AplicacionArray">  
         <sequence>  
         <element name="abonadoArray" nillable="true" 
type="impl:ArrayOf_tns1_Aplicacion"/>  
         <element name="aplicacionArray" nillable="true" 
type="impl:ArrayOf_tns1_Aplicacion"/>  
      </sequence>  
   </complexType>  
</schema>  
<schema 
targetNamespace="http://notanot/jboss-net/services/ServicioWEBAd
minNE";; xmlns="http://www.w3.org/2001/XMLSchema";;>  
   <import 
namespace="http://schemas.xmlsoap.org/soap/encoding/";;/>  
   <complexType name="ArrayOf_tns1_Aplicacion">  
      <complexContent>  
         <restriction base="soapenc:Array">  
            <attribute ref="soapenc:arrayType" 
wsdl:arrayType="tns1:Aplicacion[]"/>  
         </restriction>  
      </complexContent>  
   </complexType>  
</schema> 

Problem ID Description
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The generated Workshop Web Service Control has: 
public static class AplicacionArray implements 
java.io.Serializable  
   {  
      public anyType[] abonadoArray;  
      public anyType[] aplicacionArray;  
   } 

public static class anyType implements java.io.Serializable  
   {  
      private static final long serialVersionUID = 1L;  
      public XmlObject[] t;  
   }

anyType[] is not supported by 10.2 Workshop Web Service Control. Therefore, the above 
Service Control after upgrade will cause errors during deployment or application archive. 

Workaround: After upgrade change the types in the service control to point to the concrete 
type. For example: 
public static class Aplicacion implements java.io.Serializable  
   {  
      public byte[] certificado;  
      public java.lang.String descripcion;  
      public java.lang.String idAplicacion;  
      public java.lang.String nombre;  
      public java.lang.String organismo;  
   }

public static class AplicacionArray implements 
java.io.Serializable  
   {  
      public Aplicacion[] abonadoArray;  
      public Aplicacion[] aplicacionArray;  
   }

CR291057 ebXML application using ebXMLControl within java custom control results in a Null 
Pointer Exception when ControlHandle.sendEvent is not used.

Workaround: Read the note and example to JPD and Control Callback section of the 
WebLogic Integration 10.2 Upgrade Guide. 

CR290904 Upgraded XQuery files corresponding to transform functions returning XMLObject 
may fail to execute at runtime. 

Workaround: Modify the XQuery function signature to specify a return value with multiple 
occurrence.

Problem ID Description
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CR290169 Interface WSDLs are not supported by Workshop for WebLogic Platform 10.2 Web 
Service Control. 

This will result in an application deployment error if BPEL Import results in the generation 
of Workshop Web Service Control for an interface WSDL. 

Workaround: Add dummy implementation elements - <service> and <binding> - to the 
WSDL after BPEL Import. 

CR287857 BPEL Import generates Workshop Web Service Control for external services specified 
as partnerlinks. Workshop Web Service Control does not successfully resolve external 
schemas imported using relative URIs into the WSDL (associated with the Service 
Control). 

Workaround: Copy the external schemas from the utility project to the web project. 
Subsequently, place the external schemas relative to the location of the WSDL in the web 
project. 

 CR287291 Upgraded 8.1 applications display compilation errors in JPDs’ and transformation 
classes. 

Applications which use log4j classes, especially in an EJB project, require the log4j.jar 
file to build. The location of the log4j.jar file has changed from 8.x to the 10.2 release 
and needs to be specified manually. 

Workaround: After upgrading the project, manually add the log4j.jar file to the project 
build path. 

CR282449 XmlObject[ ] is not supported as a parameter for a JWS callback operation. 

CR282428 In 10.2, weblogic.jws.Types annotation for JWS does not support array types. 

8.x JWS/Workshop Web Service Control with jws:parameter-xml/jws:return-xml 
annotation's include-java-types having an array type defined as a value will not upgrade 
successfully to 10.2. 

Workaround: Re-design the JWS/Workshop Web Service control before you begin to 
upgrade. 

Problem ID Description
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CR281279 JAX-RPC (Tylar) binding does not support schemas that reference xsd:schema 
element. 

As shown in the following code sample, this lack of support effects generation of Workshop 
Web Service Control/JWS (using JAX-RPC binding) from a WSDL with references to 
xsd:schema element. 

<xsd:complexType>  
   <xsd:sequence>  
      <xsd:element ref="xsd:schema"/>  
      <xsd:any/>  
   </xsd:sequence>  
</xsd:complexType> 

Workaround: Assign a name to the element and use the xsd:anyType, as shown below. 

<xsd:complexType>  
   <xsd:sequence>  
      <xsd:element name="schema" type="xsd:anyType"/>  
      <xsd:any/>  
   </xsd:sequence>  
</xsd:complexType> 

CR275039 weblogic.jws.Types annotation is not supported on Callback operations of a 

JWS. 

Workaround: Refactor the service to not use the weblogic.jws.Types annotation. 

CR275002 A JWS with w3c.dom.* (Document, Element and DocumentFragment) as parameter 
or return type is not supported. 

Workaround: Operation signature and return types of JWS that used w3c.dom types will 
have to be changed to use SAAJ types. The internal implementation of the operations will 
have to be updated to translate to or from SAAJ and w3c.dom types. 

CR274286 An upgraded JWS that returned an XMLBean type will not compile. 

All operations on an upgraded JWS that returned an XMLBean type will have a compile error 
post upgrade. The message indicates that the return type doesn't match the element name 
defined by the XMLBean's schema. 

Workaround: Remove the @WebResult annotation or change the name to match the 
schema type. 

Problem ID Description
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CR278519 There are two known issues in wftracking/M2_ArchHelloAsync.java file and 
Process_Tracking_Binary.java. Remove throws Exception from 
helloDelay_onTimeout methods.

After the issues were resolved the issues, the following errors were seen in the Problem 
window.
1. The project was not built since its build path is incomplete. Cannot find the class file for 

weblogic.xml.xmlnode.XMLNode. Fix the build path then try building this project 
(wfTrackingWeb).

2. The type weblogic.xml.xmlnode.XMLNode cannot be resolved. It is indirectly 
referenced from required .class files.

Workaround: Add weblogic.jar to the external jars list in the build path to resolve the 
above issues.

CR277695 While executing an 8.x application in WebLogic Integration, comment strings are 
displayed in the test browser console. 

Workaround: Works as designed. The Upgraded JPD will have comments so they are shown 
on test browser. Remove the comments after you the upgrade.

CR265847 Upgrade required for Clients that use SOAP 1.2 messaging format.

Workaround: The WSDL for the Web Service changes during the upgrade to WebLogic 
Integration 10.2. To conform to the new specification, you need to regenerate the clients of 
Web Services that use the SOAP 1.2 messaging format.

CR240167 JMS control does not process incoming messages asynchronously in 10.2 

In 8.x, a JPD could use a JMS Control to process incoming messages asynchronously. This is 
not supported in 10.2 and will cause the JPD to fail. 

Workaround: Replace the JMS Control with the WebLogic Integration JMS Control to 
process incoming messages asynchronously. 

CR235276 Use of non-SOAP XML message format over HTTP or JMS protocol is not supported. 

In 8.x releases, the non-SOAP XML message format was supported over the HTTP or JMS 
protocol for JWS. In Workshop for WebLogic Platform 10.2, only the SOAP protocol is 
supported. So, an upgraded JWS front ending JPD will not function. 

Workaround: Remove the JWS front ending JPD and create a HTTP or a JMS event 
generator to receive the non-SOAP XML message. Subsequently, create a message broker 
subscription in the JPD to receive non-SOAP XML messages, from the recently created 
HTTP or JMS event generator. 

Problem ID Description
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